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1.1.

1.2.

1.3.

About this manual

Copyrights

Theinformation in this document is subject to change without notice and should not be
construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for any
errors that may appear in this document.

In no event shall ABB Oy beliablefor direct, indirect, special, incidental, or consequential
damages of any nature or kind arising from the use of this document, nor shall ABB Oy
be liable for incidental or consequential damages arising from use of any software or
hardware described in this document.

This document and parts thereof must not be reproduced or copied without written per-
mission from ABB Oy, and the contents thereof must not be imparted to athird party
nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under alicense and
may be used, copied, or disclosed only in accordance with the terms of such license.

© Copyright 2012 ABB. All rights reserved.

Trademarks

ABB isaregistered trademark of ABB Group. All other brand or product names men-
tioned in this document may be trademarks or registered trademarks of their respective
holders.

General

This manual provides thorough information on the MNSis OPC Server and the central
concepts related to it. You find instructions on how to configure the MNSis OPC Server
related abjects. The basic operation procedures are also discussed.

Information in this user’s manual isintended for application engineers who configure
the MNSis OPC Server.

This user’'s manual is divided into following sections:

Introduction

This section gives an overview of the MNSis OPC Server and its features.
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1.4.

1.5.

Configuration

In this section you will find an overview of configuration. You are given instructions
on how to configure MNSis OPC Server related objects and the model of asubstation
or system.

Document conventions

The following conventions are used for the presentation of material:

» Thewordsin names of screen elements (for example, thetitlein thetitle bar of a
window, the label for afield of adialog box) areinitially capitalized.

+  Capitd lettersare used for the name of akeyboard key if it islabeled on the keyboard.
For example, pressthe ENTER key.

» Lowercaseletters are used for the name of akeyboard key that is not labeled on the
keyboard. For example, the space bar, comma key, and so on.

*  PressCTRL+C indicates that you must hold down the CTRL key while pressing
the C key (to copy a selected object in this case).

+ PressESC E Cindicates that you press and rel ease each key in sequence (to copy
a selected object in this case).

»  Thenames of push and toggle buttons are boldfaced. For example, click OK.

»  The names of menus and menu items are boldfaced. For example, the File menu.
»  Thefollowing convention is used for menu operations: MenuName > M enu-

Item > CascadedM enultem. For example: select File > New > Type.

»  The Start menu name alwaysrefersto the Start menu on the Windows taskbar.

»  System prompts/messages and user responses/input are shown in the Courier font.
For example, if you enter avalue out of range, the following message is displayed:

Entered value is not valid. The value must be 0 - 30

* Youcan beasked to enter the string MIF349in afield. The string is shown asfollows
in the procedure:

MIF349
»  Variables are shown using lowercase | etters:

sequence name

Use of symbols

This publication includes warning, caution, and information icons that point out safety-
related conditions or other important information. It also includes tip icons to point out
useful information to the reader. The corresponding icons should beinterpreted asfollows.



1MRS756569

Grid Automation Controller COM600 4.0

MNS iS Connectivity (OPC) User's Manual

1.6.

A\
A\

The electrical warning icon indicates the presence of ahazard
which could result in electrical shock.

The warning icon indicates the presence of a hazard which
could result in personal injury.

The caution icon indicates important information or warning
related to the concept discussed in the text. It may indicate
the presence of a hazard which could result in corruption of
software or damage to equipment or property.

The information icon alerts the reader to relevant facts and
conditions.

Thetip icon indicates advice on, for example, how to design

Q your project or how to use a certain function.
Terminology

Term Description

Alarm An abnormal state of a condition.

Alarms and Events; AE

An OPC service for providing information about alarms and
events to OPC clients.

Data Access; DA

An OPC service for providing information about process data to
OPC clients.

Data Object; DO

Part of a logical node object representing specific information,
for example, status, or measurement. From an object-oriented
point of view, a data object is an instance of a class data object.
DOs are normally used as transaction objects; that is, they are
data structures.

Data Set The data set is the content basis for reporting and logging. The
data set contains references to the data and data attribute val-
ues.

Device A physical device that behaves as its own communication node
in the network, for example, protection relay.

Event Change of process data or an OPC internal value. Normally, an

event consists of value, quality, and timestamp.
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1.7.

Term

Description

Intelligent Electronic Device

A physical IEC 61850 device that behaves as its own commu-
nication node in the IEC 61850 protocol.

Logical Device; LD

Representation of a group of functions. Each function is defined
as a logical node. A physical device consists of one or several
LDs.

Logical Node; LN

The smallest part of a function that exchanges data. An LN is
an object defined by its data and methods.

LON

A communication protocol developed by Echelon.

LON Application Guideline for
substation automation; LAG

A proprietary method of ABB on top of the standard LON pro-
tocol.

OPC

Series of standards specifications aiming at open connectivity
in industrial automation and the enterprise systems that support
industry.

OPC item Representation of a connection to the data source within the
OPC server. An OPC item is identified by a string <object
path>:<property name>. Associated with each OPC item are
Value, Quality, and Time Stamp.

Property Named data item.

Report Control Block

The report control block controls the reporting processes for
event data as they occur. The reporting process continues as
long as the communication is available.

SPA ABB proprietary communication protocol used in substation
automation.
SPA device Protection and/or Control Product supporting the SPA protocol

version 2.5 or earlier.

Substation Configuration Lan-
guage; SCL

XML-based description language for configurations of electrical
substation IEDs. Defined in IEC 61850 standard.

Abbreviations
Abbreviation Description
AE Alarms and Events
ASDU Application Service Data Unit
BRCB Buffered Report Control Block
DA Data Access
DMCD Data Message Code Definition
DO Data Object
GW Gateway, component connecting two communication networks together
HMI Human Machine Interface
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Abbreviation Description

IEC International Electrotechnical Commission

IED Intelligent Electronic Device

LAG LON Application Guideline for substation automation
LAN Local Area Network

LD Logical Device

LMK LonMark interoperable device communicating in LonWorks network. In

this document, the term is used for devices that do not support the ABB
LON/LAG communication.

LN Logical Node

LSG LON SPA Gateway

NCC Network Control Center

NUC Norwegian User Convention

NV Network Variable

OLE Object Linking and Embedding

OPC OLE for Process Control

P&C Protection & Control

PLC Programmable Logic Controller

POU Program Organization Unit

RTS Request To Send

SA Substation Automation

SCD Substation Configuration Description

SCL Substation Configuration Language

SFC Sequential Function Chart

SLD Single Line Diagram
SNMP Simple Network Management Protocol
SNTP Simple Network Time Protocol
SOAP Simple Object Access Protocol

RCB Report Control Block
URCB Unbuffered Report Control Block

XML eXtended Markup Language
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Related documents

Name of the manual MRS number
COM®600 User’s Manual 1TMRS756125
Document revisions

Document version/date Product revision History
A/17.6.2008 3.2 Document created
B/13.2.2009 3.3 Document revised
C/06.11.2009 34 Document revised
D/30.6.2011 3.5 Document revised
E/31.5.2012 4.0 Document revised
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2.1.

2.2,

2.3.

Introduction

Functional overview

MNSiS OPC server is used for the communication to the MLink devices. COM600 and
MLink devices are physically connected together using the LAN connections. MNSiS
OPC server is connected to the COM600 software using an MNSiS connectivity server.
MNS S connectivity server remodels and links the data from the MNSiS OPC server
tothe lEC 61850 datamodel used by the COM 600 applications. OPC DA isused between
the MNS iS OPC Server and the connectivity server.

OPC Server

IEC 61850
Data Modelling

OPC Client

Il

MNS iS
Connectivity
Server

MNS iS
OPC Server

Figure 2.1-1 MNSI S connectivity server overview

IEC 61850 data modeling

|EC 61850 data modeling is described in further detail in section IEC 61850 data mod-
eling of COM600 User's Manual.

Features
The MNSIS connectivity server supports the following features:

« OPC DataAccess Server v. 1.0/2.0
e OPCAlarms and Events Server v. 1.10

11
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« OPC DataAccess Client v.2.0
« |EC 61850 data modeling

The following data can be used from MNSiS OPC DA Server in COM600:

+  Measurement values

» Tripand aarm indications

« Device Status indications

«  Communication status indications

Timestamps for data changes in the MNS iS OPC DA OPC server are not transferred
from IEDs. They are created by the OPC server based on the computer system time.

The recommended maximum number of M Control devices that can be connected to one
COM®600 is 180.
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3.1.

3.2.

3.3.

Configuration

About this section

This section describes the installation and configuration of the MNS iS OPC server.

Overview of configuration

To commission COM600 MNS S, install the MNS iS OPC Server to the COM600
computer. The COM600 MNSiS Connectivity Server configured using Station Automa-
tion Builder 600 (later referred to as SAB600).

The configuration of the MNS iS OPC Server prepares COM600 to communicate with
the MNSISdevicesand retrieving the datato the OPC server namespace. The connectivity
server configuration linksthe datafrom the MNSiS OPC Server to COM600 framework,
to be used with other COM600 functions like the HMI and gateway.

MNS iS OPC Server installation and configuration

Installing MNS iS OPC Server

Toinstall the MNS S OPC Server, run the executable file C:\AMNSi S\setup.exe.

DCOM Configuration
When configuring the MNS iS OPC server, run under COM600 user account

To modify the DCOM configuration:

1. Sdect Start > Control Panel > Administrative Tools > Component Services >
Component Services > Computers> My Computer > DCOM Config.
Right-click ABB MNSiS OPC DA Server and select Properties.

In the Identity tab, select This user.

Enter COM600 to the User field and the correct password to the password fields.
Click Apply to accept the changes.

gD

If the password of the COM600 user is changed later, for example, with the SAB600
management tool, the password must be manually changed for the MNSiS OPC server
as described above.

13
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Namespace Configuration

MNSiS OPC server software package has a service which scans the network for MLink
devices. When MLink devices are found, they are added to the OPC server namespace.
If apreviously found device does not respond, it is removed from the namespace. If the
COM®600 configuration includes OPC items that are not found in the namespace, the
namespaceiscyclically scanned for any changes. Missing itemswill be used, if they are
found during the cyclic scan.

MNS iS OPC Connectivity Server Configuration using
SAB600

Building Object Tree

Building the object tree in the communication view of SAB600 is described in section
Building object structures of COM600 User's Manual.

In the communication structure, the subnetwork object is used to group the MControl
devices which are connected to separate MLink devices. If the communication status of
the MLink is needed as an own signal, an own IED for the Mlink must be created as
well. Below this|ED an LD and LLNO with Health mapped to the communication status
must be created. MControl devices are presented as IEDs in the tree. The data from the
M Controlsis model ed as data objects below logical nodesand logical devices. The LLNO
Health must be mapped to the communication status OPC item of the MNSiS OPC
Server.
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Figure 3.4-1 MNSiS OPC server object tree example

3.5. Configuring objects

Server and subnetwork object do not normally need any change to the default values of
the properties. On the IED object, the event definition for the device connection status
is configured according to the needs of the project.

Data abjects contain the OPC item paths to the MNS iS OPC server. This specifies the
source data used to update the values of the data object. Below is an example of SPS
data which getsits value from the M Link33.2.DeviceStatus.GPI 1 OPC item from the
MNSiS OPC Server.

+  Update Rate property specifies the maximum rate the OPC server updates the item.
»  The shortest rate supported by the MNSiS OPC Server is 1000 ms.

15
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|Object Properties

- 1 x|

B

E [010] Basic
E1850-Type
OFC Server ID
State OFC Item Path
Sub Type
Update Rate

= [040] OPC Alarm and Event
Indication Event

= [090] 5cale and Unit
Scale

E Misc
Caption
Description

SPS

Default
MLink33.2.DeviceStatus. GPI1
Basic

1000

AlarmState

Ind1
GPI1

Figure 3.5-1 An example of MNS S object properties

MNSIS_object_properties.png
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